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Workaround:  Avid recommends that you avoid using generic or nondescriptive tape names 
— for example, do not use the tape name “Live” for a live feed. Instead, use distinctive tape 
names for each capture. Also, you can use separate projects when capturing with your 
editing system. When you change projects, even if you use the same tape name for your 
captures the Avid system generates new source IDs. This prevents the relink problem.

➤ Bug Number: UDevC26084. If you are working with DV tapes in the Sony HVR-M10U 
you might experience “failed to find preroll errors”.

Workaround:  Change the machine template to the “Generic_DVDevice-NTSC” or 
“Generic_DVDevice-PAL” template. This will force the software to use a different method 
for cueing to the preroll timecode.

➤ Bug Number: UDEV00225379. The editing application does not warn you if you try to 
send a Frame Chase editing clip to Media Services Transcode. Do not send ingesting clips to 
Media Services Transcode. Wait until the clip is completely ingested.

➤ Bug Number: UDevC00086768. You might see the following error message when loading 
a clip captured by Frame Chase capture in the editor: “Error encountered during relink 
process: New track length does not equal original track length.”

Workaround:  In the editing application, right click the clip and sequence and select Update 
from Interplay. In Assist, refresh the clip from the Interplay database by selecting the clip 
and pressing F5.

➤ Bug Number: UDEV00195662. When you are capturing and using the passthrough 
monitor, desktop passthrough might cover error messages that are in the same space as the 
passthrough monitor, preventing you from being able to read them.

Workaround:  Move the affected window or message box away from the Record monitor, 
put another application in front of the Avid application, and then go back to Avid to force the 
UI to refresh. 

➤ Bug Number: UDEV00220761. When you capture from an HDV device through 1394 into 
an HDV interlaced project, you might see the video break up into squares. The captured 
media is intact and complete, however.

➤ Bug Number: UDEV00197055. When you capture media that includes invalid frames, you 
might see an error message that the capture has been aborted and the invalid frames 
discarded; it asks you if you want to keep the clip. This message is incorrect; the invalid 
frames have not been discarded.

Workaround:  Click No to discard the clip, and then recapture using new marks that 
exclude the bad sections on the tape. Do not keep the clip.
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➤ Bug Number: UDEV00204777. When you deselect Enable Confidence View in the Video 
Display Settings dialog box and then open the Capture tool, the Client monitor does not 
display passthrough.

Workaround:  Do one of the following:

t Select Enable Confidence View.

t Click the Capture button in the Capture tool.

➤ Bug Number: UDEV00184515. In an HDV project, you can only capture audio at the 48k 
sample rate. Because the incoming audio is digital over FireWire® , the software is unable to 
up-sample 32k and 44.1k audio reliably during capture. If you try to capture audio at another 
sample rate, you do not receive the error message warning that the audio on the tape does not 
match the setting in the Audio Project Settings dialog. Currently, only the 48k sample rate is 
supported in the HDV project format.

➤ Bug Number: . If you lose connection to your 1394 port or receive “OHCI Port Busy” 
errors, check the FireWire cable length. 

➤ Bug Number: . When you capture HDV, the system might not find the preroll point if the 
Preroll setting is set to 3 or below. The default is set to 6. Do not set this option to 3 or below.

➤ Bug Number: UDEV00183907. (HDV) Passthrough does not work if Delay Audio is set to 
7 frames or greater. (The Delay Audio option appears in the Capture tool.)

Workaround:  Set Delay Audio to 6 or fewer.

➤ Bug Number: UDEV00181815. Drop frame/Non-drop frame mismatch errors occurred 
often when capturing. A new Deck Preference setting has been added. Access the Deck 
Preferences Settings dialog box. A new “When the deck contains no tape Log as” option 
appears. Select the timecode format (Drop Frame or Non-drop Frame) for logging clips 
when no tape is in the deck. When a tape is in the deck, the system automatically uses the 
existing timecode format on the tape.

➤ Bug Number: . (HDV) When switching from one project format to another while connected 
to an HDV device, you must turn the HDV device off and then turn it back on again. 

➤ Bug Number: . (Windows) If after initially setting up a DV deck for the first time, or after a 
system recovery you cannot see the deck, manually register the DV buffers file by doing the 
following:

Workaround:  
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Perform the following:

1. Go to Program Files\Common Files\Avid.

2. Right click Dvbuffers.ax.

3. Select Open.

4. Choose to select the program from a list and click OK.

5. Browse to windows/system32.

6. Select regsvr32.exe.

➤ Bug Number: UDEV00145432. The following error message, “Exception: 
ADM_DIO_ERROR_OCCURRED, DIOerr:Expected DV50 NTSC but received 
DV25NTSC” appears if you attempt to capture DV 25 from a DV 50 source or DV 50 from 
a DV 25 source. 

➤ Bug Number: UDEV00139553. When you batch capture long clips with a lot of metadata, 
the following error appears and no media is captured: “Exception: 
MXFDomain::SaveMetaDataToFile - Failed to save meta data to file.” This does not occur 
when you batch capture OMF.

➤ Bug Number: . When you capture from a Panasonic AJ-SD93P or Panasonic AJ-SD93E, 
note the following: the Panasonic default for DIF SPEED is set to S400. The Adrenaline and 
Avid Mojo expect a DIF SPEED of S100. Capture fails, producing scrambled or blocky 
images.

Workaround:  From the Panasonic DVCPRO deck's menu, set the menu DIF SPEED to 
S100.

➤ Bug Number: . When you capture DVCPRO HD from a Panasonic HD 1200A deck, keep 
the menu DIF SPEED set to S400.

➤ Bug Number: UDEV00163093. (NewsCutter Software Only) Capturing media using the 
Sony DVMC-DA1 transcoder might produce clips where a/v is out of sync.

Compatibility

➤ Bug Number: UDevC00121033. Playing back EVS media on a Symphony Nitris (classic) 
is not supported. Playback is supported for Symphony Nitris DX.

➤ Bug Number: UDevC00110632. (Windows) If you are running a Digidesign audio device, 
such as the Mbox 2, with the editing application and that device appears to be inactive:
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Perform the following:

1. Quit the editing application.

2. Run the Digidesign Audio Drivers Installer Program in the Avid Utilities Folder.

3. Reboot the system.

4. If the audio device is still inactive, access C:\Program 
Files\Digidesign\Drivers\DigiDriver.exe and select “Install.”

For Windows Vista 64, the location is C:\Program 
Files(x86)\Digidesign\Drivers\DigiDriver.exe.

➤ Bug Number: UDevC00100881.  You cannot connect to a Sony e-VTR device when using 
e-VTR manager on a Microsoft Vista32 or Vista64 systems. The Sony e-VTR logging 
application does not support Vista. 

➤ Bug Number: UDevC00119004. Previously, the Best Performance Video Quality option 
(yellow/yellow) was the only option available when working with HD projects in 
MultiCamera Mode. The yellow/green video quality option is now available in MultiCamera 
Mode when working with HD projects. 

➤ Bug Number: UDevC00112765. Currently, it might take longer to load a LongGop 9-way 
or Quad Split source view.

➤ Bug Number: UDevC00105849. If you open the Audiosuite tool when unlicensed plug-ins 
are installed, the system will lock up. 

Workaround:  Either remove the demo or unlicensed plug-in from your system. Or connect 
the iLok dongle that has the valid license key to the system.

➤ Bug Number: UDevC00104160, 00024645. If your original project was a 1080i50 or 
1080p25 project, when you are working in a 25i PAL project, the bin headings for MPEG 30 
and MPEG 50 might not be accurate. 

➤ Bug Number: UdevC00102207. (Macintosh) If you find that your mapped F keys are not 
working, go to System Preferences > Mouse and Keyboard > Keyboard tab and make sure 
“Use F1-F12 keys to control software features” is checked.

➤ Bug Number: 99387. Currently, if you are exporting a QuickTime movie and select the 
Custom option, you might receive an Access Violation and a Structured Exception loop 
dialog. You must force quit the application or select Abort on the Structured Exception 
dialog box. In QuickTime player, go to Edit > Preferences > QuickTime Preferences, then 
select the Advanced tab and select “Safe mode (GDI only)” under video.
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➤ Bug Number: UDevC00098170,UDevC00098065. If you are working on a 
standard-definition (SD) project with an Avid Nitris DX or Avid Mojo DX attached to your 
system, you cannot use the Best Performance mode for video playback. If you open an SD 
project created on a system with an Avid Adrenaline attached and utilize Best Performance 
mode, the Avid Nitris DX system promotes the video quality to Draft Quality. Either click 
the Video Quality button and select Draft Quality or Full Quality, or change the project type 
to the appropriate high-definition format.

➤ Bug Number: UDevC00101326. Currently, if you export a QuickTime movie and convert 
the sample rate on export, it might result in bad audio.

➤ Bug Number: Udevc00101033.  (Adrenaline, Vista) If you are running your editing 
application on the xw8400 or xw8600 computer you must have the HP 1394a FireWire card 
(Avid PN 7030-20154-01; HP PN PA997A) or the Sonnet Technologies™ Allegro™ 
FW400 1394a FireWire card installed. You may experience "Huffman Decode" errors 
during batch capture or capture on-the-fly if you run with an unapproved Firewire card.

➤ Bug Number: UDevC00097564. Currently, if you are on a Vista 64 editing application and 
you try to open a bin that was created on a Windows XP editing application, you might 
receive an “Unable to open file” message. The issue is that when you move a file from the 
desktop to the project folder, it loses access rights. Access the file as an administrator and 
add Authenticate Users with Full Control.

➤ Bug Number: UDevC00093513. (Macintosh) The editing application might not launch if 
your system volume name contains "/" . Make sure the computer volume name does not 
include a “/”.

➤ Bug Number: UDevC00090317. A non Administrator cannot send or receive EDLs. You 
must be an administrator to use EDL Manager.

➤ Bug Number: UDevC00079997. (FilmScribe) The Tape Name does not appear in a cut list 
when you select the TapeID column heading.

Workaround:  If you select both the Reel# and TapeID column heading, the Tape Name 
appears.

➤ Bug Number: . (Macintosh) When you are using the search feature in the Avid editing 
application Help, a bug exists if Safari™ is your default browser. You might experience 
issues when performing searches. You need to empty the Safari cache in between searches 
(Select Safari > Empty Cache.) This search issue does not occur when you use Firefox™ as 
your browser.
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➤ Bug Number: UdevC00007737. If you are using an Mbox 2 and an HP8400 computer, you 
should connect the Mbox 2 to a rear USB port. The USB ports on the front of the HP8400 
can cause problems with the Digidesign Driver Installer. Once the installation is complete, 
you can connect the Mbox 2 to the front or rear USB ports.

➤ Bug Number: UDEV00140811, UDEV00140767, UDEV0221008. If you are using the 
Safari browser to access the Avid Learning Excellerator™ site (select Help > Learning 
Resources, and then click the Avid Learning Excellerator link), you must have Javascript® 
and cookies enabled (Safari > Preferences > Security).

➤ Bug Number: UDevC00052206. Due to changes in Avid Media Composer v2.5.x 
(Macintosh), some third party AudioSuite and AVX plug-ins may not load properly. This is 
due to moving the Avid editors to Xcode® from CodeWarrior™ 9 for support of the new 
Mac Intel® based systems. Customers may need to upgrade their AudioSuite and AVX 
plug-ins. Please note that Avid has informed Third Party partners of this change. Third Party 
plug-ins that have not been updated will not be supported in this release.

➤ Bug Number: UDevC00079523. If you are a non-administrator and you want to launch 
AudioSuite Plug-Ins, make sure you have an administrator make you a member of the 
AvidUsers group which is automatically created during installation. 

➤ Bug Number: UDEV00219672. You currently cannot select HDV projects in the 
MediaLog™ application.

➤ Bug Number: UDEV00164891. (NewsCutter XP Software Only) When working with the 
HP/Compaq nw8000 laptop, if you press the volume button (which is located on the front of 
the laptop, not on the keyboard), this causes an overwrite in the source/record edit to the 
Timeline.

➤ Bug Number: UDEV00141328. Sending to Digidesign® Pro Tools: When you export an 
OMF 2.0 file that links to MXF media, you should first transcode the MXF Media to OMF 
media. If you have a long sequence containing MXF media, you are not prompted prior to 
the export process that the export will not be successful. To save time, transcode MXF media 
to OMF media prior to exporting as OMF 2.0.

➤ Bug Number: UDevC00091387. Due to an issue with the RICOH FireWire controller on 
the Dell M65 and M90 laptops, when playing out to the host in 1394 mode, as well as a DV 
device via the “Output to DV Device” option, video and audio may drift out of sync.

Workaround:  Turn off “Output to DV Device.” Or, if you have to use the DV Device for 
monitoring, connect the speakers or headphones to the DV device/camera instead of the PC.
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➤ Bug Number: UDevC00120475. Editing keyboard shortcuts such as Ctrl+X and Ctrl+C do 
not work in MetaSync Manager. Use the menu commands.

Digital Cut

➤ Bug Number: UDevC00102676. When performing a digital cut, you will receive the 
message “If you have a genlock signal connected to your BOB, please switch it to match the 
output rate. Use an appropriate black burst sync source. Then wait for the REF light on the 
BOB to turn green and press Continue.” If the light turns green, press Continue and the 
digital cut will be performed. If not, make sure an appropriate sync source is connected and 
wait for the REF light to turn green.

➤ Bug Number: UDevC00097111.  (Avid Nitris DX/Avid Mojo DX) Currently the blue bar in 
the Timeline might not reach the end of the sequence at the end of a digital cut. All frames 
are actually cut to tape. 

➤ Bug Number: UDevC00118267.  A “Media Offline in Composition” error might occur 
with a Digital Cut even when all media is online. Select Continue to perform the Digital Cut.

➤ Bug Number: UDEV00222537. (Macintosh) When performing a 720p/59.94 digital cut, 
the first frame of the sequence might be missing.

Workaround:  Add half a second of black before the sequence.

➤ Bug Number: UDEV00220887. The first 35 frames of a sequence might be missing when 
you perform a digital cut after selecting Crash Record and Ignore Time in the Digital Cut 
tool.

Workaround:  Add filler to the beginning of the sequence.

➤ Bug Number: UDEV01845957. When performing an HDV digital cut, the last few seconds 
are not cut to tape.

Workaround:  Generate a clip of black and add it to the end of the sequence.

➤ Bug Number: UDEV00174311. A digital cut of an HD project might drop the last frames 
of audio.

Workaround:  Add 10 frames of audio to the end of the sequence.

➤ Bug Number: UDEV00135921. When you perform a digital cut using the Pioneer® 
PRV-LX1 DVD recorder, select Ignore Time in the Digital Cut Tool window.
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➤ Bug Number: UDEV00136395. A video underrun might occur at the start of a digital cut if 
the Digital Cut tool does not have focus when you click the Play Digital cut button. The 
Digital Cut window must be active before you click either the Start or Preview button. If an 
underrun occurs at the very start of the digital cut, you should be able to perform the digital 
cut without a problem.

➤ Bug Number: UDEV00139484. When you perform a digital cut to a Panasonic DVCPRO 
HD deck using HD-SDI with 720p/59.94 material, several frames of black might be written 
to tape before the start of the outputted sequence. This might result in the end of the 
sequence being truncated on tape.

Workaround:  Place several seconds of black or color bars at the end of a sequence.

➤ Bug Number: UDEV00138162. The Digital Cut tool does not allow certain durations of 
black to be added to the tail of a sequence. Certain values (including 20 minutes, 30 minutes, 
60 minutes, and so on) reset the clock to zero when applied. If the value you entered resets to 
zero when applied, adjust the value upward or downward until a satisfactory length is 
determined (at which point the clock does not reset itself and the desired duration is 
correctly applied).

Dynamic Relink

➤ Bug Number: 103557. Any MPEG2 352_30I MXF media created with an x.8.1 or x.8.3 
editing application will not relink in Exact match in versions x.8.4 of the editing applications 
or the Media Composer 3.0 or Symphony 3.0 or NewsCutter 7.0 versions of the editing 
application. The MPEG2 352_30I MXF media created with an x.8.1 or x.8.3 was 
compressed at 15MB instead of 2MB and therefore will not relink in Exact match. 

Workaround:  Change the Dynamic Relink settings to use the “Most compressed” option 
or change the “If no match is found” option to “Relink to Closest.”

➤ Bug Number: UDEV00225796. When working with HDV projects, HDV resolutions are 
not available for Dynamic Relink. 

Workaround:  Choose “Use Closest Media” instead of “Relink to Offline” when in HDV 
projects and “Specific Resolution” is selected as the Relink Method. If you do not choose 
“Use Closet Media”, captured clips appear as offline when Dynamic Relink is enabled.

➤ Bug Number: UDEV00221144. If you want to re-create title media at a target format other 
than the working format, you must change the project format to that designated for the 
target, otherwise only the working format resolutions are available.
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Effects

➤ Bug Number: UDevC00118276. You might experience dropped frames on the initial 
playback of a sequence containing a Pan and Scan effect. 

Workaround:  Set the Image Interpolation option in the Render Settings to Standard 
(Bilinear).

➤ Bug Number: UDevC00112035. You might receive a bus error when exporting a sequence 
in a 24p NTSC project that contains a scratch removal effect. Render the sequence first.

➤ Bug Number: UDevC00117131. Currently, you cannot preview Multi channel audio clips 
with AudioSuite Dynamic 3 plug-in effects. The plug-ins work in the Timeline.

➤ Bug Number: UdevC00117990. If you try to conform an AFE created from the Avid Media 
Composer or Avid Symphony editing application to Avid DS, the Color Correction 
animation effects will not conform. The effects will be replaced with a wipe effect. You 
should demote the color corrections. Right-click the sequence that contains the Color 
Correction effects and select Demote Effects. This creates a a duplicate sequence that you 
can open in Avid DS.

➤ Bug Number: UDevC00114633. When you apply a SubCap or TimeCode Burn-In effect to 
a clip with the Effect Editor set to Thumbwheels, the first few characters in the text field are 
cropped from view. They do appear properly on the image.

➤ Bug Number: UDevC00113832. Applying Boris Continuum Complete deinterlace above 
other effects might corrupt the image.

➤ Bug Number: UDevC00115301. You might receive an “AudioSuite DAE” error when you 
render a master clip with a ReelTape AudioSuite Plug-in. The error does not occur if you 
render in the Timeline. 

➤ Bug Number: UDevC00118588. The Tracking window becomes deselected after switching 
from a nested effect to the top-most effect. You must close and then reopen the Tracking 
window to make it available.

➤ Bug Number: UDevC00118505 . Currently, a Superimpose or Dissolve effect does not 
promote to 3D Warp.

Workaround:  First promote to Advanced Keyframe, then to 3D Warp.

➤ Bug Number: UDevC00109451.  When the Color Correction window is open, Loop Play 
will include the sequence, not just the current clip, even if the Effect Editor is open.
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➤ Bug Number: UDevC00120950. You might experience dropped frames when playing back 
an HD sequence containing a Safe Color limiter effect with the “422 Safe” option selected.

➤ Bug Number: UDevC00113368. When working in 3D Advanced keyframes, occasionally, 
keyframe points might not display in the path.

Workaround:  Click the Enlarge or Reduce button located below the Effect Preview 
Monitor.

➤ Bug Number: UDevC00106944. In a 1080i59 project, effects that invert or resize the image 
might appear field-reversed during play in an SD timeline.

Workaround:  Transcode the media to SD.

➤ Bug Number: UDevC00097157. A clip with an unrendered TimeWarp effect might not 
import to ProTools. Render the effect before exporting.

➤ Bug Number: UDevC00090708. If you try to run AudioSuite and receive the following 
message, “Your computer is missing a Windows XP update required by ProTools. Please 
install all available critical updates before installing ProTools” you must perform a Windows 
Update, Custom Install to ensure the correct dll is installed.

➤ Bug Number: UDevC00003573. While in Effect mode, you might not be able to scrub 
through blue dot effects and have the monitor update. Move the Effect Editor so that it 
overlaps some part of the Composer monitor. The monitor should now update correctly 
when you scrub through blue dot effects.

➤ Bug Number: UDEV00225614. Safe Color limits might be exceeded in SD downconverted 
output from an HD project. In an HD project, if you use the Safe Color Limiter effect to 
ensure safe colors in a sequence and then output that sequence using SD downconvert, some 
transient pixel values might exceed your safe color ranges. This is a consequence of the 
resizing process performed in the Avid Nitris or Adrenaline hardware during an SD 
downconvert.

Workaround:  Change the project type to an SD type before you output or render the 
sequence.

➤ Bug Number: UDEV00219374. In 30i or 1080i60 projects, Timewarp effects that use the 
Film With 2:3 Pulldown Input format might not render correctly. Some frames might remain 
unrendered or it might not be possible to complete the render. This problem is known to 
occur in the specific circumstances described below, but might also occur in other 
circumstances.
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Partial Render. The problem might occur if you perform a partial render of a Timewarp 
effect using the Film With 2:3 Pulldown Input format, then render the remaining part of the 
segment. Some frames might remain unrendered or the second part of the segment might not 
render.

Division of rendered segment. The problem might occur if you render an entire Timewarp 
effect using the Film With 2:3 Pulldown Input format, and then divide the segment (for 
example, by performing an overwrite edit of new material into the middle of the segment). 
Some frames in the second part of the divided segment might become unrendered.

Trimming head frame of rendered segment. The problem might occur if you render an entire 
Timewarp effect using the Film With 2:3 Pulldown Input format, and then trim the head 
frame of the segment. Some frames in the segment might become unrendered.

➤ Bug Number: UDEV00207851. You might not be able to render a FluidBlur, 
FluidColorMap, or FluidMorph effect in an HD project if there is not enough memory 
available.

Workaround:  Try one of the following:

t In the Bins tab of the Project window, click the Clear button, and render the Fluid effect 
(see “Managing Bins and Memory” in the Help).

t Close all unused bins, relaunch, and render the Fluid effect.

t In the Format tab of the Project window, switch the project format to an SD format, 
render the Fluid effect, then switch back to HD.

➤ Bug Number: UDEV00221706. Very high speed Motion Effects with rates greater than 
500% no longer play in real time; they now appear in the Timeline as a blue dot effect, and 
must be rendered. Since any motion effect with a rate greater than 100% plays back 
inefficiently, and the higher the rate the less efficiently it plays back, real time playback 
efficiency will improve by rendering such motion effects.

➤ Bug Number: . (HDV) If a clip contains Timewarp effects, you should render the effects.

➤ Bug Number: . You might experience effects render issues with stacked effects.

Workaround:  Render each individual track starting with the bottom track.

➤ Bug Number: UDEV00197962 . When you are working with AVX effects, performing an 
Expert Render or a Render IN to OUT on a sequence that contains multiple third-party AVX 
effects might lead to excessive memory consumption that could cause the application to 
hang or to display errors.

Workaround:  Render the effects in smaller groups.
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➤ Bug Number: UDEV00214545. AVX 1.0 effects might have invalid color levels.

➤ Bug Number: UDEV00194693. You might see problems with superblacks in 16-bit mode.

➤ Bug Number: UDEV00189486. Performing an Add Edit on a promoted Advanced 
Keyframe Picture-in-Picture effect might cause a “DataPointOneError”.

Workaround:  Instead of first promoting to 3D, then Advanced Keyframe, promote in the 
reverse order.

➤ Bug Number: UDEV00132940 . You might see a “FluidMotion Vector Edit Requires Full 
Resolution” error if you work in FluidMotion™ Vector Edit mode in anything other than full 
resolution (green mode in the Timeline). Render FluidMotion effects before you combine 
them with any other effects, especially any other time-based effects.

➤ Bug Number: . (Progressive projects only) If a clip contains any of the following effects, 
you must render the effects before you apply Scratch Removal:

• Timewarp effects 

• Any effect that has been promoted to the Advanced Keyframe model

➤ Bug Number: UDEV00134286. Removing or undoing some timewarp effects might cause 
audio and video to lose sync.

➤ Bug Number: UDEV00161774 . In the Transition Corner Display mode, two of the six 
frames display incorrect frames during trim operations initiated from the Timeline.

Workaround:  Trim using the Trim buttons.

➤ Bug Number: UDEV00144549. The Fluid film 2:3 timewarp effect might render 
incorrectly when you are rendering fluid motion type. The effect might flash a crop of left 
and right edges.

Workaround:  Set the left and right mask in the FluidMotion Editor to zero.

➤ Bug Number: UDEV00164929. (HD only) Any animated alpha matte over 35 seconds long 
might fail.

➤ Bug Number: UDEV00163592. When an Avid effect is applied in an SD 24p progressive 
project, it can create unwanted aliasing on the resulting clip.
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Effects (Pan & Zoom)

You might encounter the following limitations when you use the Pan & Zoom effect:

➤ Bug Number: UDevC00119611. If you run out of memory when using Pan & Zoom, resize 
the images to a lower resolution using an application such as PhotoShop.

➤ Bug Number: UDevC00088408. (Macintosh) After the link to a Pan & Zoom effect is 
broken and you want to reestablish it, the application doesn’t prompt you for the source 
image name in the Open dialog box.

Workaround:  Import still images into a bin and use them in the edit. With the imported 
image in the Timeline, apply the Pan & Zoom effect and load the respective file from the 
Open dialog box. This way you can use “Clip Text” and confirm that the correct images are 
being loaded.

➤ Bug Number: UDevC00088408. (Macintosh) After the link to a Pan & Zoom effect is 
broken and you want to reestablish it, the application doesn’t prompt you for the source 
image name in the Open dialog box.

➤ Bug Number: UDevC00081281 . Pan & Zoom keyframe settings can revert to defaults if 
you select all keyframes when you link to a new picture.

➤ Bug Number: UDevC00025291. When you zoom in with Hi Qual and Ultra Qual filtering, 
you might experience a system error (Windows) or see green lines when you preview 
(Macintosh).

➤ Bug Number: UDevC00090139. To improve memory issues, the options in the Pan & 
Zoom Cache Fast menu are ignored and Video Resolution is used, although when you render 
the effect, the highest-quality resolution is always used. After you partially render a Pan & 
Zoom effect, however, you might see a slight pixel shift when you move between the 
rendered and unrendered portions.

Export

➤ Bug Number: UDevC00112498. QuickTime Movie export fails when using the Qualcomm 
PureVoice audio compressor. 

➤ Bug Number: UDevC00117134. (Mac Intel) You might have received "image buffer" errors 
when exporting to DNxHD in After Effects 7. This error does not occur with After Effects 
CS3 or CS4.
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➤ Bug Number: UDevC00106032. (Macintosh) Exporting HDV files to the desktop results in 
a 0 k file on the desktop. The file will actually appear in your Macintosh User folder. If you 
export to a folder, note that the file will actually be created one folder level above.

➤ Bug Number: UDevC00090871. (Macintosh) When sending a QuickTime Reference to 
Sorenson Squeeze, Auto Load and Reveal Files do not work. Squeeze will launch, but the 
sequence does not load nor are the files revealed in the Finder window.

Workaround:  Manually import the files into Sorensen Squeeze.

➤ Bug Number: UDevC00098849, 103011. (Macintosh) If you try to Export to a read only 
drive you may get an exception. Ensure you are exporting to a writable drive.

➤ Bug Number: UDevC00102078, 101999. Export to HDV Device will fail on PC if your 
sequence contains native HDV media (HDV media captured from tape). Does not apply to 
Mac systems.

Workaround:  Transcode to another resolution before performing the export.

➤ Bug Number: UDevC00081152. An error might occur when you export to HDV when the 
first frame of the sequence is a video mixdown clip.

Workaround:  Place filler or a frame of non-video mixdown media at the head of the 
sequence.

➤ Bug Number: UDevC00049124. Currently, our export settings allow a 720x486 size when 
you export Avid DV, which creates a field alignment issue. Make sure that you set the export 
settings correctly for 720 x 480 for DV exports. Currently, QuickTime must do a resize from 
486 lines down to 480 and you receive an odd interpolation. (Even if you specify 720x486, 
the Quicktime file displays 720x480.)

➤ Bug Number: UdevC00054456. In NTSC, QuickTime Same as Source and QuickTime 
Reference clips containing DV material can sometimes show visual distortions when burned 
to DVD from Avid DVD. This is because the DV portions are resized from the DV raster 
size 720x480 up to the standard NTSC raster size 720x486.

Workaround:  When exporting the QuickTime Same as Source or Quicktime Reference 
clips, choose “Use Avid DV.”

➤ Bug Number: UdevC00007778, UDevC00025957. (Macintosh) The editing application 
might crash after exporting to an Avid Unity ISIS Read-only workspace. Make sure you 
export to a Read/Write workspace. You can determine whether a workspace is Read/Write 
through the Client Manager application. Navigate to the Workspaces tab in Client Manager. 
The Read/Write workspaces are listed with an R/W under the name of the workspace. 
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➤ Bug Number: UDevC00078454, UDevC00081066. If you have a mixed-resolution DV 25 
sequence and try to export it as QuickTime for DVD using the Apple DV Codec, the .mov 
might contain artifacts.

Workaround:  You must use the Avid DV Codec for this kind of sequence.

➤ Bug Number: UDEV00180852. You might receive exception errors when exporting HDV 
1080i/59.94 or 1080i 50 as Windows Media.

➤ Bug Number: UDEV00181835. When exporting to an HDV device, at least 4 to 5 seconds 
of media might be missing from the beginning of the sequence.

Workaround:  Add 10 seconds of color bar or black filler at the beginning and at the end of 
the sequence.

➤ Bug Number: UDEV00140687. When you export a QuickTime Reference movie, do not 
mix DV and non-DV media. If you mix DV and non-DV media, the resulting movie might 
contain line shifts.

➤ Bug Number: UDEV00087119. When you export pan automation on an audio clip as AAF, 
it does not translate in Pro Tools. Pro Tools does not accept varying value pan controls 
during import.

➤ Bug Number: . In the Export Settings dialog box, the default size is not the image size of 
the opened project.

➤ Bug Number: UDEV00086337. When you play an exported clip in the Windows Media 
Player, the sequence stalls in the desktop monitor. The audio plays, the blue bar progresses 
in the Timeline, and the video and audio output to the client monitor is OK. If the clip that is 
loaded in Windows Media Player is removed, then the Play operation plays properly in both 
the desktop and client monitors.

➤ Bug Number: UDEV00138232. Exporting Locators exports only a .txt file with frame 
count information, not timecode or Feet and Frames. Import also supports only frame count.

➤ Bug Number: . (Encoding to Windows Media) A “Not enough memory is available to 
complete this operation or WM_BeginWriting_FAILED” error results from the application 
running out of available memory (RAM) while you perform the encode. Encoding to a 
Windows Media Video codec requires a lot of memory. The amount of memory required is 
directly related to the number of audio and video profile streams, width, height, bit rate, 
number of passes, VBR/CBR, and quality of the encoded video, as well as the resolution of 
the source media. If you encode HD media, you might need to reduce the bit rate, turn on 
2-pass encoding, turn on VBR, lower the quality, or reduce the frame dimension.
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➤ Bug Number: . A “WM_FindInputFormat_FAILED” error might appear if the Windows 
Media exporter cannot find a suitable input format for a video or audio stream contained in 
the current Windows Media Export setting's stream profile. For example, using non-standard 
frame dimensions might result in this error. See the Microsoft Windows Media web site for 
more detail.

ICS (International Character Support)

➤ Bug Number: UDev00089590. Workspace names that contain non-ASCII characters can 
cause poor performance when working in a bin. 

Workaround:  Use only ASCII characters in workspace names.

➤ Bug Number: UDevC00051974. If you capture a clip from a workspace with a French 
name through CaptureManager™, in the Avid editing application the bin heading Drive 
might be empty where it should list the French name of the workspace.

➤ Bug Number: UDevC00051060,UDevC00088815. If you change the font or font size of 
your input, and see characters rotated 90 degrees, make sure you select the correct font. Do 
not use any font that begins with the “@” symbol.

➤ Bug Number: UDevC00052541. Do not create a project using the Euro currency character 
(ALT 0128). The project fails to be created and a “Can't Open Project” error message is 
displayed.

➤ Bug Number: UDevC00022395, 22346. Certain Asian characters might not appear in the 
correct order in some text boxes in your Avid editing application.

Import

➤ Bug Number: UDevC00049653. Occasionally, if you cancel an import of a clip, you might 
receive a “DISK_SHARING_VIOLATION” error.

➤ Bug Number: UDEV00086727. When you import an uncompressed QuickTime file, a 
PICT image, or a TIFF image, the first 4 or 5 vertical columns of pixels might truncate when 
you display the file in the Source, Record, or client monitors.

➤ Bug Number: UDEV00141372. When you batch import a sequence with a graphic 
animation that was created in a 30i project and then modified in a 720p project, it might not 
import.

Workaround:  Import the graphic and manually edit it back into your sequence.
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➤ Bug Number: UDEV00138270. Avid editing systems cannot import AVI files created on 
Avid DS Nitris systems. The import fails with an error message stating that the file format is 
not supported for import.

Installation

➤ Bug Number: UDevC00102551.  (Macintosh) When launching the editing application, and 
the Audio is initializing, “CoreMIDIServer.framwork” might bounce in the dock. It may 
remain in the dock until you quit the editing application.

Workaround:  Delete DigiDioMidDriver.plugin from the Library/Audio/Drivers folder.

➤ Bug Number: UdevC00106344. After installing the editing application on the Vista OS, 
when you choose to reboot the system, the shutdown cycle is longer than usual. 

➤ Bug Number: UDevC00103563. On Windows platforms, occasionally the PACE installers 
do not properly update the iLok drivers.  PACE iLok drivers are used to copy-protect 
Digidesign plug-ins. If this happens the AudioSuite functionality in MediaComposer will be 
disabled.  To correct the situation the user should uninstall all instances of Interlok Drivers 
from the Windows Add Remove Control Panel and re-install the Digidesign Drivers from 
the CD or from Avid > Utilities.

➤ Bug Number: UDevC00103537. Once you install the editing application, and once the 
editing application tries to launch, while it is initializing, you might receive an “Unable to 
create index for editor slides” error message. 

Workaround:  Right click the product.exe and choose “Run as administrator.” This causes 
the mdb and pmr files to update in the Avid_MediaFiles folder.The executable is located (by 
default) in C:\Program Files\Avid\Avid Product Name.

➤ Bug Number: UDevC00103474. (Vista) When the editing application is launched and a 
firmware update is required, you might be prompted to relaunch using 'Run As 
Administrator'. To run as administrator, right click the product.exe and select Run as 
administrator. The executable is located (by default) in C:\Program Files\Avid\Avid Product 
Name. Run as administrator is not available by right-clicking in the Avid editing application 
Shortcut icon.
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Interplay Workgroup

➤ Bug Number: UDevC00105773. When you create a video or audio mixdown and add a 
locator, you might receive an “Exception: CM_NO_TC” error when you try and check the 
clip in to Avid Interplay. If you add the locator in Assist, then go back to the editing 
application and perform an Update from Interplay on the clip, the clip will check in 
successfully.

➤ Bug Number: UDevC00105408. (Vista) If you have a P2 drive mounted and you try to 
open the Interplay Service Configuration tool, you might receive an Exception error. 
Clicking through the error message might allow you to open the tool. If you unmount the P2 
drive, the tool will open.

➤ Bug Number: . When checking out a complex or long sequence from an Avid Interplay 
environment the following message might appear: “A request for data from the asset 
manager is taking a long time to complete. Would you like to continue waiting for the 
operation to complete or would you like to cancel?” If you choose to wait the sequence may 
load or you may get this message multiple times until the check out actually occurs.

➤ Bug Number: UDevC00091228. Selecting Check In All Open Bins from the Fast menu 
(hamburger menu) in the bin might not check in the open bins. 

Workaround:  To check in all open bins, select Check In All Open Bins from the File 
menu.

➤ Bug Number: UDevC00090338. After you perform a search for media in the Interplay 
Window, you cannot refresh the search results displayed in the Research panel by pressing 
F5. If you want to refresh the results, repeat the search.

➤ Bug Number: UDEVC00052480. Batch Import of files containing Alpha. This problem 
occurs if you want to batch import files in SD and HD formats and then use Dynamic Relink 
to switch between the different formats. The problem occurs with QuickTime movies, 
graphics, and sequences that contain alpha. You can batch import the files and relink to the 
different formats, but if you exit and then restart the Avid editing application you can no 
longer relink to the HD format. The system displays an “Exception: NO Compressed Data 
Format found” error message.

Workaround:  You cannot use Dynamic Relink with HD and SD clips that contain alpha. 
Import the HD files with alpha as individual clips. When you want to switch to HD format, 
edit the HD versions into your sequence.
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➤ Bug Number: UDEV00227044. If you import a graphic from your local drive into a project 
in an Avid editing application, change the original name of the clip to a name of your choice, 
and check that clip into a folder in the Interplay Window, the new name does not appear in 
the Interplay Window even when you refresh the window. You see only the original name.

➤ Bug Number: UDEV00217606. In the Avid editing application, the Record Track monitor 
buttons might be deselected if the following happens:

1. On System 1, you create a sequence and check it into a folder in the Interplay Window.

2. On System2, you check out the sequence and load it into the Timeline.

3. On system1, you edit the sequence and check it into the Interplay folder again.

4. On system2, you refresh the Interplay window then check out the same sequence again.

Workaround:  Select the Record Track buttons again.

➤ Bug Number: UDEV00299154 . In an Avid editing application, if you have a sequence that 
you have not checked into the Interplay Window and you try to use the Transfer > Send to 
Workgroup command, you might experience an error.

Workaround:  Check the sequence into the Interplay Window before you attempt to 
transfer it.

➤ Bug Number: UDEV213923 . In workgroup environments prior to Avid Interplay, you 
could automatically consolidate from NewsCutter during Send to DMS. With the Avid 
Interplay release, the automated consolidate is not available. Choose to consolidate prior to 
sending to DMS.

➤ Bug Number: UdevC0055755. When working with MultiRez, high-quality audio cannot be 
distinguished from up-sampled proxy audio created with previous versions of the editor. For 
instance, an 8 kHz proxy audio up-sampled to 48 kHz on import in Interplay version 1.0 is 
considered as good as a real 48 kHz high quality audio. In that case, if MultiRez is set to use 
48 kHz audio, it picks up the most recent file of the two.

Force Disconnect Client Mode in an Interplay Environment

Your system administrator might need to temporarily remove your editing system from 
access to the network. This might occur if new software needs to be installed or if 
components need to be updated, for example. To force a disconnect, your administrator runs 
a script that forces disconnection from the network without physically removing your 
system. Your administrator can also reconnect your system at the appropriate time using 
another script.
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It is possible to import from shared drives and export to them in Forced Disconnected Client 
mode. Avid recommends, however, that you do not import from or export to shared drives 
when your administrator has force-disconnected your editing system. Avid does not support 
any workflow that includes importing from or exporting to shared drives when the system is 
in Forced Disconnected Client mode.

In general, if you are in Forced Disconnected Client mode and if you import or export using 
shared drives, after the import or export those drives might appear to be available for other 
purposes such as importing, capturing, playing, or deleting media, but they are not available. 
Similarly, options for shared storage might appear to be available in various settings dialog 
boxes and shared drives and media might appear in various menus, tools, and applications; 
Avid does not support use of these settings, drives, or media.

To remove the shared drives from your drive lists, disconnect your network cables as 
described in “Voluntarily Disconnecting from the Interplay Environment” in the Help, or 
exit your editing application and restart it.

The following limitations describe specific instances of drives and options appearing in 
Forced Disconnected Client mode:

➤ Bug Number: UDevC00083319 . In the Select Project dialog box, shared workspaces and 
projects are available and should not be.

➤ Bug Number: UDevC00083320,UDevC00083772.  Shared drives and media are available 
in the Media tool and in the MetaSync™ application and should not be.

➤ Bug Number: UDevC00083321. In the Interplay Server Settings dialog box, you can 
change the Interplay server name and you should not be able to

➤ Bug Number: UDevC00083371 . In the Capture tool, you can select the Interplay Folders 
option as your capture destination and you should not be able to.

➤ Bug Number: UDevC00083374. In the MXF Media Files tab of the Capture Settings dialog 
box, you can select the “During capture, clip is updated in Interplay” option and you should 
not be able to.

➤ Bug Number: UDevC00083477.  In the Temporary File Directory option of the General 
Settings dialog box, you can type the name and location of a shared drive and you should not 
be able to.

➤ Bug Number: UDevC00083409. Shared drives and media are visible in the Hardware tool 
and should not be. 
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➤ Bug Number: UDevC00083740. Shared drives are visible in the Import dialog box and 
should not be.

➤ Bug Number: UDevC00083826. Options in the Media Services Settings dialog box are 
available and should not be. 

➤ Bug Number: UDevC00083496. Options in the Transfer Settings dialog box are available 
and should not be. 

➤ Bug Number: UDevC00084455, 84773.  Selecting LANshare, PortServer settings, or 
ProEncode™ appears to be available but should not be. Do not select these options.

➤ Bug Number: UDevC00084446. Dynamic Relink can be enabled but that should not have 
been allowed. Do not enable it. 

➤ Bug Number: UDevC00084600, 84844.  With several of the options in the File menu, you 
are allowed to select a shared workspace as a destination but you should not be able to. Do 
not select a shared workspace in this context.

➤ Bug Number: UDevC00084610.  If you select Automatic Login at Project Selection in the 
Interplay User Settings dialog box, enter Disconnected Client mode, exit the mode and the 
editing application, reconnect, and then restart the editing application, you need to log into 
Interplay again and you shouldn’t have to.

➤ Bug Number: UDevC00088542.  In Forced Disconnect mode, if you make a change to your 
User settings, the change might appear for all other users, as well.

JVC 

➤ Bug Number: UDevC00106545. JVC recommends using the BR-HD50 deck to capture 
and batch-capture HDV media recorded with JVC cameras.

➤ Bug Number: 106030. The JVC GY-HD250U camera might drift out of sync while 
shooting in 720p/59.94. To avoid this issue, turn on the camera in 720p 23.976 and then 
switch the format to 720p 59.94 causing a soft reboot.

➤ Bug Number: UDevC00106380. The Imported M2T files that were captured with a JVC 
GY-HD250U camera via the FireStore DR-HD100 will show up in the bin with the wrong 
durations. This occurs in 720p 50 and 720p 60 projects.

➤ Bug Number: UdevC00106401. Currently, captured or imported M2T files might contain 
1/2 frame offset. This occurs in 720p 29 and 720p 25 projects.
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Locators

➤ Bug Number: UDevC00080303. If you add a locator to a shotlist, and then open the 
sequence in an editing application, the locator appears, but if you perform a match frame on 
the locator, it might not appear in the master clip.

Workaround:  In the editing application, check the master clip in question out of Interplay 
and then update the bin or the clip. The locator appears.

➤ Bug Number: . A new item has been added to the Fast menu in the Locators window. 
“Disable Locator Popup” disables the locator pop-up window. It is disabled only for the 
work session. When you restart the Avid application, the locator pop-up menu is enabled.

➤ Bug Number: UdevC00079172. (Macintosh) When you export locators from the Locator 
tool, the file might not be saved with the correct .txt extension and you might not be able to 
import it.

Workaround:  In the Choose Location for Exported Locators dialog box, add the file name 
extension .txt to the end of the file name before you click Save, or add the extension to the 
saved file before you import it.

Panasonic P2

➤ Bug Number: UDevC00101216. Reveal File does not function on master clips linked from 
P2 cards or virtual volumes.

➤ Bug Number: UDevC00098594, UDevC00097992. Panasonic P2 writeback is not 
supported on the Macintosh platform.

➤ Bug Number: . Export to P2 limitations:

• Use Marks and Use Enabled tracks are ignored on export.

• All Audio must be PCM 16b/48K.

• All audio tracks will be exported, although P2 devices either support 2 or 4 audio tracks. 
Therefore sequences should be built for delivery to the specified P2 playback device. 
Sequences with 6 audio tracks will have 6 audio tracks and the P2 device will only 
playback the first 2 or 4 tracks.

➤ Bug Number: . Importing P2 limitations (Macintosh):
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• Importing P2 Clips in a bin is only supported with one P2 Card mounted. With two or 
more P2 cards mounted, use the Media Tool, select the P2 Drives, click All Projects and 
click OK. All Master Clips from the P2 cards will appear in the Media Tool. Drag them 
to a bin.

• When importing from the Panasonic P2 Store device, Media Tool must be used as well 
on Macintosh.

➤ Bug Number: . SD/HD Mixed sequences are not supported.

➤ Bug Number: . 1:1 MXF media cannot be exported in both SD and HD projects. Transcode 
1:1 MXF before exporting.

➤ Bug Number: . (Macintosh) Hotswapping P2 cards with the editor launched is currently not 
supported.

➤ Bug Number: UDevV00090107. Occasionally the File > Import P2 > Media command 
does not consolidate media to the drives.

Workaround:  Close and re-open the bin and then execute the command again.

➤ Bug Number: UDevC0056503. When you view a P2 clip that spans across multiple P2 
cards in the timeline, you might be surprised as to what you see and don't see due to the 
history of mounting P2 cards on your current system and the P2 cards that are currently 
mounted. Be aware that even though media is offline, or you are not able to view the P2 
media in the Timeline, the media is not lost. The media appears when the card containing it 
is mounted.

➤ Bug Number: 00080719. If you have P2 clips on a P2 card and you display the clips in the 
Media tool, you might be able to delete the audio and video .mxf files from the Media tool. 

➤ Bug Number: UdevC00058135. If you remove a card from a slot in the P2 reader and do 
not put another card in the reader, you must delete the P2 folder before inserting that same 
card in another slot.

➤ Bug Number: UdevC00058133. A DVD drive cannot be a media drive. If a CONTENTS 
folder is located on the root level of the DVD, you might see a “No clips were found” 
message when performing an Import P2 Clips to Bin. 

Workaround:  Create a folder that contains the CONTENTS folder on the DVD. This 
instructs the editor to mount a virtual drive.
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➤ Bug Number: UDevC00051731. When the P2 CONTENTS folder is located at the root 
level on a drive where the Avid editing application looks for media files, you might 
encounter errors when importing P2 clips. For example, if you are working on a laptop, the 
Avid editing application and local storage folders are on the same drive and are usually 
located at the root level. If you create virtual P2 volumes on the Desktop, you might 
encounter a “No clips were found” message when trying to import the P2 clips and media. 

Workaround:  If you locate the virtual P2 volume in a different location such as a subfolder 
on the Desktop, you should be able use virtual P2 volumes. 

➤ Bug Number: . If you experience unusually long scan times, check to make sure both the 
local time and Greenwich Mean Time (GMT) are set correctly on your camera. If the GMT 
is not set correctly, you may need updated firmware for your camera. 

➤ Bug Number: . Play performance for a multi-stream sequence suffers when you directly 
access media from the P2 media cards in the AJ-SPX800P camera.

➤ Bug Number: UDEV00163029. If you turn off the P2 card reader while a bin accessing P2 
media is open, attempting to load any P2 clip results in a DISK_FILE_NOT_FOUND 
message in the Source monitor window. The message should read Media Offline.

➤ Bug Number: UDEV00163032. Dupe detection is not available for P2 source material.

➤ Bug Number: . The following limitations currently apply when working with AVC-Intra 
resolutions:

• Real-time playback support on Avid Symphony Nitris is not guaranteed.

• QuickTime export is not supported.

➤ Bug Number: UDevC00116685.  You cannot export a QuickTime movie using the Same as 
Source option with AVC-Intra material. ProEncode does not work with AVC-Intra material. 
This is related to the QuickTime problem because ProEncode creates a QuickTime 
Reference movie as part of its process.

➤ Bug Number: . If you encounter unusually long consolidation times when working with the 
P2 device, make sure you are using the USB cable supplied by the P2 manufacturer. 

Play

➤ Bug Number: UDevC00117308. You might experience dropped frames when playing back 
XDCAM media with effects. When playing back media, a number of variables affect play 
performance; such as your CPU power, GPU power, sequence complexity and the raster 
settings.
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➤ Bug Number: UDevC00109242. (MacBook Pro) After an initial launch of the editing 
application when attached to a Mojo, you might receive an “Assertion failed” error when 
playing back an HD sequence. 

Workaround:  Switch the project to NTSC or PAL.

➤ Bug Number: UDevC00101060. You might experience a slight delay at the start of play 
when Output to DV Device is enabled with progressive projects.

➤ Bug Number: UDevC00117987. It is possible on certain slower machines, when playing in 
MultiCamera mode, you might notice one or more cameras or the line-cut stutter a few 
seconds into the sequence. This happens most often when displaying the MultiCamera 
composite or line-cut to the client monitor on these older, slower systems. To help improve 
performance, Avid has provided a console command which allows you to pre-render more 
frames. This will slow down the start of play, but improve the overall playback 
performance.To increase the number of pre-render frames:

Perform the following:

1.  Open the Console window by selecting Tools > Console.

2.  In the Console command line, type the following command followed by the number of 
frames you want to prerender:

multicampreload 20

3. Press Enter (Windows) or Return (Macintosh). The value is saved. You do not need to 
reenter the command when you relaunch the editing application. To restore the default 
value, enter the command with no value.

➤ Bug Number: UDevC0088738. When you scrub a clip with “Fast Scrub” on, you might 
notice that when you stop scrubbing, the video may continue to play in the record monitor. 
This might be more noticeable in HD projects or when you are working on shared storage. 
Fast scrub actually has a number of frames in flight while you drag the blue bar. The in 
process frames continue to play once you stop scrubbing.

➤ Bug Number: UDevC00103865. (Mojo DX) Currently, if you open a 24p PAL, 25p PAL or 
720p 50 project and load a clip into the timeline and then play the clip, you may see frames 
drop. 

Workaround:  Set your project to an HD project type and then back to your 24p or 25p 
project. You only have to do this once per session.

➤ Bug Number: UDevC00026088. When you play media and then you press stop, the source 
monitor stops, but the external client monitor steps back approximately 2 frames.
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➤ Bug Number: . (Macintosh) QuickTime reference movies are useful as long as you are 
working with Avid media files available on your local system or in an Avid Unity 
environment. However, if you expect to move the exported QuickTime file to a system that 
doesn't have access to the media, then you should use the standard QuickTime export so the 
media files and QuickTime wrapper can be moved as one file.

➤ Bug Number: Udev00209633. With Full Screen Playback enabled on a single monitor, the 
video might stutter and you might notice tearing toward the top of the image during 
playback. Tearing might also appear if you use variable-speed play.

➤ Bug Number: . When the Avid editing application stops streaming play, a number of 
additional frames are sent to the DNA device in order to keep the client monitor synchronous 
with the desktop display. The DNA device must play out that number of frames after the 
desktop has stopped playing. To make sure you view the actual last frame, the application 
then snaps the client monitor back to the frame on the desktop. This might be more apparent 
when playing HD media.

➤ Bug Number: . If you do not see video output to your device, make sure that the appropriate 
device is selected in the Special > Device menu. If FireWire is selected in the Device menu, 
make sure Output to Device is selected in the Video Display Settings.

➤ Bug Number: Udev00141002. If you experience a flashing monitor when attempting to 
play using the Japanese version of Windows XP, and your monitor does not appear to be 
covered by anything, adjust the state of your Language bar by maximizing and minimizing 
it. This restores the ability to play.

➤ Bug Number: . (Adrenaline) LTC output is now off by default. To turn it on, open General 
Settings and enable “Generate LTC On Playback”.

Projects

➤ Bug Number: UDevC00100476. The following project types do not support XDCAM or 
HDV raster types:

• 1080p 23.976

• 1080p 25

The only raster type available for these formats is Standard.

➤ Bug Number: UdevC00025426. (Windows Only) Avid Attic folders can only be created by 
Administrators. An Administrator has to first launch the application, open a project, close 
the project and quit the application. Then when a non-Administrator user uses the 
application, their work is saved to the Avid Attic.
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➤ Bug Number: UDevC00099790. You should note the following when transcoding media. If 
you have a project in one format, such as 1080i 50 and you add a supported progressive 
format to the clip such as 1080p 25, once you transcode the media, if you try to delete the 
clip, the clip contains both progressive and interlaced media. The delete dialog does not 
indicate that the clip you are trying to delete contains both progressive and interlaced media.

➤ Bug Number: UDevC00025979. For NewsCutter projects, you can only select base 
timecode (TC1) display formats in the Tracking Information menu. You can view other 
timecode formats in the Timeline window, but tracking information does not display above 
the Source/Record monitor except for the base timecode.

Settings

➤ Bug Number: UdevC00989750. If you take your user settings from your Adrenaline, Mojo 
or Software Only system forward to a system running with a Nitris DX, Fast scrub will be 
disabled. New user settings with a system running with a Nitris DX will have Fast Scrub 
enabled by default.

➤ Bug Number: UDevC00100486 . Currently, when saving toolsets, the bin position is not 
saved.

➤ Bug Number: . Do not carry User Profiles from a previous version to this version. Create 
new user settings. If you do use previous settings, the size of tools and windows might not be 
as expected, especially tools and windows that have been updated for this version.

Titles

➤ Bug Number: 0107356. (Macintosh) You might see vertical gray lines when you 
horizontally scroll the pages of a crawling title in Title Tool.

➤ Bug Number: UDevC00107065. (Macintosh) The background image might not display 
when editing an existing title from the Timeline.

Workaround:  Either promote the title to Marquee, or modify the existing title from the bin.

➤ Bug Number: 106910.  (Adrenaline) Currently, an image might appear distorted in the Title 
Tool if you are in Draft or Best Performance play back mode. 

Workaround:  View the image in the Title Tool in Full Quality or Full Quality 10-bit mode.

➤ Bug Number: UDevC00054752. If you re-create a rolling or crawling title in your 
sequence, the Scroll Position parameter values for the first and last keyframes are not 
preserved. They are set to the default values (start and end).
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Workaround:  Promote the title to advanced keyframe model before you re-create.

➤ Bug Number: UDevC00047857. (Macintosh only) If you select the classic Title tool 
eyedropper and then quit the Avid application, the application hangs.

Workaround:  Deselect the Title tool eyedropper before you exit the Avid application. 

➤ Bug Number: UDevC00080610. Avid suggests that you do not attempt to edit the nested 
tracks of a re-created rolling or crawling title. If you attempt to select or edit one of these 
types of nested tracks, an error occurs. This is also the case with a re-created static title on its 
alpha channel subtrack. 

➤ Bug Number: UDevC00080134. A sys_error occurs when you modify a title to an available 
drive with Render settings that are set to an unavailable drive (a drive that you do not have 
write access to). A .bak file of the title also appears in the bin.

Workaround:  Close the Title tool and change the Render settings to a drive that you do 
have write access to.

➤ Bug Number: UDEV00218429. Character spacing might be inaccurate in Title Tool titles 
using large font sizes. Some character pairs might appear too close together, or overlapping. 
In HD projects, the problem is only visible in the rendered title clip in the bin. In SD 
projects, the problem is visible immediately in the Title Tool. Also, once the problem has 
occurred in text using a large font size, it might persist when you create other text objects in 
the title at any font size.

Workaround:  The best general workaround is to promote the title to Marquee®. Text in 
Marquee titles does not have the same problem at large font sizes. Also, if you do not need 
your final text to use a large font size, avoid converting it to a large font size at any point in 
your workflow, or retype it as a new text object at a smaller size if increasing the font size 
causes the problem.

➤ Bug Number: UDEV00218032. Marquee title format does not need to change in normal 
workflows. In most normal workflows, the title format in Marquee automatically matches 
the project format in your Avid editing application and you do not need to change it. If you 
change the title format in Marquee so that it does not match the project format in your 
editing application, you might see artifacts around the edges of some title objects. One 
situation in which you might need to change the Marquee title format occurs when you are 
creating a title by opening an existing .mqp file. If the .mqp file’s format does not match the 
project format in your Avid editing application, you should change the title’s format to 
match the project format in your editing application. For more information on changing the 
title format, see “Changing Title Formats” in the Marquee Help.
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➤ Bug Number: UDEV00221549. When you render a rolling or crawling NTSC SD title with 
Same as Source selected in the Media Creation dialog box in an HD project, you might see 
problems with the title.

Workaround:  For highest quality titles, re-create your title media in the format of the 
project in which you are working; in this case, re-create your SD title media in an HD 
format.

➤ Bug Number: UDEV00189160. Unrendered back-to-back titles in a 1080i HDV sequence 
might not play in real time. The second title does not display.

Workaround:  Render the titles.

➤ Bug Number: UDEV00162337. Rolling and crawling titles in 24p and 25p projects might 
display a “Layout Mismatch” error when in Full Quality mode.

Workaround:  Select another quality mode. The error also goes away if you toggle to the 
HD project equivalent and load the title.

➤ Bug Number: UDEV00163549. When you reedit a Marquee title in the Timeline, you 
might see artifacts in the video background. This is cosmetic only and does not appear in the 
resulting title.

Workaround:  If you reedit the title in the bin rather than the Timeline, the artifacts do not 
appear.

➤ Bug Number: UDEV00163010. For projects whose formats are changed to HD, if there are 
Marquee crawls in sequences, these need to be modified to keep them as Avid DSK titles. 
Reedit these titles by using the effect editor to bring up Marquee. If when saving to a bin in 
Marquee you receive a message that the title is animated or that it cannot be saved directly to 
the Timeline, then perform the following workaround.

Workaround:  Select the Crawl text box. Press the “C” toolbar button within Marquee to 
cause the crawling text box to extend for the new larger width of the title. Now you should 
be able to save to the bin or the Timeline as before and the title will not be animated.

➤ Bug Number: UDEV00161170 . Page breaks appear on rolling and crawling titles when an 
HD title is over SD media, or an SD title is over HD media.

Workaround:  Recreate the title at the same resolution as the underlying video.
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➤ Bug Number: UDEV00136646/UDEV00136165. HD titles appear aliased when you are 
not in Effect mode. Some titles you create in HD projects might look aliased (blocky) when 
you view them at Full Quality in Source/Record mode. To improve the visible quality, render 
the title or view it in Effect mode.

➤ Bug Number: UDEV00134561. The application might appear frozen after you edit a 
Marquee title in the Timeline. If you edit a Marquee title that is already part of a sequence in 
the Timeline and then exit Marquee, you might not be able to perform any other operations. 

Workaround:  Press the Escape key. Use a different user setting to avoid the problem.

➤ Bug Number: UDEV00138188. Rolling titles created in SD and rendered in HD display 1 
line at the top of the matte when they are rendered.

Workaround:  Recreate the title and matte before you render.

➤ Bug Number: UDEV00135729. If you change the size of text, it might yield different 
kerning results. If you highlight text and change the text properties, the kerning result might 
be different than if you had changed the text properties in the Parent text box. For consistent 
results, change the text properties in the Parent text box.

➤ Bug Number: UDEV00140546, and UDEV00140564. When you edit large or unrendered 
SD crawling or rolling titles in an HD project, switch to SD, promote the title to Marquee, 
save the title in SD, then open the title in HD. 

This workaround is not possible for a 720p project, but you can open the 720p bin in a 30i 
project and modify the title there, as long as there is an SD version of the sequence.

➤ Bug Number: UDEV00139482. Titles created in 4x3 SD and then re-created in 16x9 (SD 
or HD) appear to shift to the left. You must manually reedit the title in 16x9 for correct 
positioning.

Workaround:  In 16x9 mode, load the original 4x3 title in the Title tool. Click the Selection 
tool, select Edit > Select All, and then click Object-Group. Click Alignment > Center in 
Frame Horiz. Save the title to the bin.

➤ Bug Number: UDEV00141084. You might receive an “Out of Range” error when you try 
to modify and then re-create rolling and crawling titles in the timeline in a 720p project.

Workaround:  Manually reedit the titles into the sequence.
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XDCAM

➤ Bug Number:  UDevC00120079. If you are working with the PDW U1 device and you 
have "Automatically Import Proxies when disk is inserted" selected in the XDCAM Import 
Settings window, you will not receive the automatic prompt to import the proxy clips when 
the disk is inserted. For this device, you must manually import the proxy clips. The high 
resolution batch import process has not changed.

➤ Bug Number: UdevC00121377. (XDCAM writeback) If you export a 720p50 or 720p59 
sequence with an odd number of frames, you will receive a message indicating the sequence 
needs an even number of frames to export successfully. Add or subtract a frame and perform 
the export again.

➤ Bug Number: UDevC00117308. You might experience dropped frames when playing back 
XDCAM media with effects. When playing back media, a number of variables affect play 
performance; such as your CPU power, GPU power, sequence complexity and the raster 
settings. Depending on the complexity of your sequence, you might need to render some 
effects if you want to preview them in real time and at full quality, or before you can output 
a finished sequence. 

➤ Bug Number: UDevC00116558. When you batch import XDCAM clips from a virtual 
volume, the system re-imports the proxy media into your bin. If you batch import XDCAM 
clips directly from the XDCAM disk, this works as intended. If you do not have access to the 
XDCAM disk, Avid recommends that you import the hi-res XDCAM media when you 
import from a virtual volume and then edit your sequence.

➤ Bug Number: . When you import XDCAM files, be aware that Avid does not support the 
batch import workflow when you are working in the following Sony XDCAM camera 
modes: Picture Cache Record Mode, Interval Record Mode, or VFR (Variable Frame Rate) 
Mode (UCC/OCC - Undercrank/Overcrank). An error message appears which informs you 
that the video is not supported. However, the High-Rez versions of these clips can be 
imported. Their timecode values, however, will be inaccurate. The Avid editor appends its 
own generic timecode to clips recorded in any of the previously mentioned modes.

➤ Bug Number: UdevC00164589. XDCAM proxy media will not export to a QuickTime 
reference movie. This is a limitation for all Long-GOP media types.

If you export as a regular QuickTime movie, MPEG 4, or as Windows Media 9, the export is 
successful. Or, you can transcode the proxy sequence to DV 25 or MPEG-IMX and then 
export as QuickTime reference.

Workaround:  Import the whole XDCAM HD clip and then transcode it.
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➤ Bug Number: UdevC00078552. The Avid editing applications refer to XDCAM HD 25 
Mbits media files as HDV 1080i 50/60. These Dynamic Relink settings are only available in 
project types 1080i/59.94 HDV or 1080i/50 HDV.

Extending Your Usable Address Space and Adding 
RAM for Improved Performance (Windows)

The Microsoft Windows XP and Vista 32-bit operating systems limit every program to 
2 gigabytes (GB) of address space. It reserves the remaining 2 gigabytes of address space for 
its own use. The operating system includes a boot-time mechanism that allows applications 
access to a larger virtual address space than was previously available. Avid provides a utility 
for setting the boot-time mechanism to extend the process address space.

For Microsoft Windows XP and Vista 64-bit operating systems, applications are allocated an 
address space well beyond the 2-gigabyte limit allocated by the 32-bit operating systems.  
No utility is needed to tell the 64-bit operating systems to allocate additional memory for the 
applications.

Setting your Avid editing system to access a larger virtual address space might improve 
working with HD projects without running out of memory. Even though you might gain 
more memory space, this can be quickly consumed with bins and complex HD effects. For 
best performance, if you choose to extend your address space beyond 2 gigabytes, you 
should install an additional 1 or 2 GB of RAM.

Using Install3GB.exe to Extend Your Usable Address Space 

It is not necessary to run this executable on Vista 64 systems. Perform this procedure on 
Vista 32 systems or Windows XP systems.

To extend the application address space:

1. Double click the Install3GB.exe file in the Utilities\3G folder where the Avid 
application is installed.

A window opens. You must have administrative privileges to run this utility.

n The hardware and software configuration you are running, Nitris DX, Nitris, Adrenaline, 
and so on, determines the amount of memory you should allocate for the application address 
space.

2. Type the amount of memory you want to allocate for the application space at the 
prompt. The recommended settings are:

- 2700 for Mojo and Adrenaline
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- 2700 for Mojo DX and Nitris DX

- 2500 for Symphony Nitris Classic

- 2700 for Software Only systems

Install3GB updates the current configuration you are running. It does not create another 
one. 

After pressing any key the window closes and you will need to reboot the computer. 

Restoring the Original Configuration

You can restore the system to the original configuration.

To restore the configuration:

1. Run the Install3GB.exe as described in “Using Install3GB.exe to Extend Your Usable 
Address Space” on page 70.

2. Type 0 (zero) for the memory setting.

This removes the “userva” setting in the boot configuration.

3. Reboot the system.

Documentation Changes

The following change has occurred since the print documentation was completed.

Non-Core AudioSuite Plug-ins

The online Help and the Advanced Guide reference Non-Core AudioSuite Plug-ins in the 
Goodies folder. Non-core AudioSuite plug-ins are not included in the Goodies folder. You 
must download Non-core AudioSuite plug-ins from the digidesign.com web site.

Unlinking Clips Procedure Update

The following procedure has been updated to clarify details on using the Macintosh with a 
multi-button mouse.

To unlink master clips from theircurrent links:

1. Select the master clips to unlink.

2. Depending on your operating system, do the following:

t (Windows) Ctrl+Shift+Right-click the clips and select Unlink.
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t (Macintosh) Using a multi-button mouse: Press and hold Cmd+Shift and 
Right-click the clips and select Unlink, or select Clip > Unlink from the main menu.

t (Macintosh) Using a standard mouse: Press and hold Cmd+Ctrl+Shift and click the 
clips and select Unlink, or select Clip > Unlink from the main menu. 

The clips are unlinked and display the message Media Offline. To enable the Right-mouse 
button functionality on a multi-button mouse, see your Macintosh documentation.

Exporting to XDCAM

In the Avid editor Help, the topic: “Exporting to XDCAM,” step 8 informs you that “If your 
exported sequence has more than two audio tracks, only two tracks are exported, even 
though the Sony XDCAM device is capable of handling 4 to 8 tracks. If your sequence has 
more than two tracks, they are mixed down during export.”

This should now read: “If you are using the Sony PDW HD1500 or the Sony PDW 1500 
XDCAM devices, export of up to 8 tracks of audio is supported for the MPEG IMX and 
XDCAM HD 50 Mbits formats. For other formats or devices that do not support 8 tracks, the 
system mixes down to audio tracks 1 and 2 during export.”

Capturing DV 25 Media

In the “Capturing DV 25 Media” topic in the help, the following paragraph was 
unintentionally omitted.

If you are using an Avid Nitris DX or Mojo DX, or if you are not using an Avid input/output 
hardware device (software-only), you use a 1394 port on your computer (Host 1394). You 
specify that you are capturing via the 1394 port by selecting Host 1394 from the Video menu 
in the Capture tool.

Selecting a DV Device

In the “Selecting a DV Device” topic in the help, the following paragraph was 
unintentionally omitted.

• If your system has an Avid Nitris DX or Avid Mojo DX attached, the DNA/1394 button 
and the Special > Device menu do not appear in the user interface. DV capture through 
1394 and non-DV capture through your input/output hardware operate independently. 
You specify that you are capturing via 1394 by selecting Host 1394 from the Video 
menu in the Capture tool.
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Selecting Asset Types

You should ignore the topic “Setting the Interplay Window Display” in the Help and use the 
following procedure. The option to select which media types display in the Interplay 
Window has been moved from the Bin menu to the Interplay Window. 

To select asset types and reference clips to display:

1. Right-click the Type column heading in the Research panel and select Set Type Filter.

n You need to right-click the column heading. If you right-click elsewhere in the column, the 
option does not appear in the context menu.

The Set Type Filter dialog box opens.

2. Select the asset types you want to display.

3. (Option) Select “Show reference clips” to display objects that are referenced by 
sequences.

4. Click OK.

5. (Option) Save the layout if you want to preserve your type filter settings.

Licensing Note on NRCS Tool Changes

The edit lock feature is supported on iNEWS v2.1 or later. When you upgrade to Avid 
NewsCutter v7.5, you must enable additional sessions. The session type varies depending on 
your version of iNEWS:
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• For iNEWS v2.1 through v2.5, you must add iiws sessions to your /site/config file, and 
you must enter the server name using the following form: servername 2.1.5.15.  The 
iiws sessions are license-controlled by iNEWS, so you must increment your iNEWS 
license string. 

• For iNEWS v2.6 or later, you must add aiws sessions to the /site/config file. The aiws 
sessions are not license-controlled by iNEWS, so you do not need to make any changes 
to your iNEWS license string. 

For information on modifying the /site/config file, see the Avid iNEWS Setup and 
Configuration Manual and the ReadMe that came with your version of iNEWS. To view the 
correct parameters for the /site/config file, log into your iNEWS server as a superuser at the 
iNEWS console and type configure ?.

Importing Proxy Media

Avid's new feature “Avid Media Access (AMA)” allows you to link directly to P2, XDCAM, 
or XDCAM EX media. However, if you want to import XDCAM proxy media, you can do 
the following. 

Turn off AMA:

1. In the Project window, click the Settings tab. 

2. Double-click AMA.

The AMA Settings dialog box appears.

3. Click the Volume Mounting tab.

4. Deselect “Enable AMA Volume Management.”

5. Quit and restart the Avid application.

6. Follow the steps in the Help topic: “Importing Proxy Media from an XDCAM Disc.” 

For more information about AMA and Importing and Exporting, see the section on “File 
Based Media” in the Help or in the Advanced Guide .pdf of your Avid editing system.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by 
visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as 
the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the 
license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license 
agreement.

Avid products or portions thereof are protected by one or more of the following United States patents: 4,970,663; 5,267,351; 
5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 
5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,719,570; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 5,754,851; 
5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 5,987,501; 5,999,406; 
6,016,152; 6,018,337; 6,023,531; 6,038,573; 6,058,236; 6,061,758; 6,091,778; 6,105,083; 6,118,444; 6,134,607; 6,141,007; 
6,141,691; 6,198,477; 6,201,531; 6,211,869; 6,223,211; 6,249,280; 6,269,195; 6,317,158; 6,317,515; 6,330,369; 6,351,557; 
6,353,862; 6,357,047; 6,392,710; 6,404,435; 6,407,775; 6,417,891; 6,426,778; 6,477,271; 6,489,969; 6,512,522; 6,532,043; 
6,546,190; 6,552,731; 6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,596,031; 6,618,547; 6,636,869; 6,665,450; 6,678,461; 
6,687,407; 6,704,445; 6,747,705; 6,763,134; 6,763,523; 6,766,063; 6,766,357; 6,791,556; 6,810,157; 6,813,622; 6,847,373; 
6,871,003; 6,871,161; 6,901,211; 6,907,191; 6,928,187; 6,961,801; 7,043,058; 7,081,900; 7,103,231; 7,266,241; 7,280,117; 
RE40,107; 7,403,561; 7,433,519; D352,278; D372,478; D373,778; D392,267; D392,268; D392,269; D395,291; D396,853; 
D398,912. Other patents are pending.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2009 Avid Technology, Inc. and its licensors. All rights reserved.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192XD I/O, 888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, Alienbrain, AniMatte, 
AudioMarket, AudioPages, AudioSuite, AudioVision, AutoSync, Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, 
Avid DNxHD, AVIDdrive, Avid DS Assist Station, Avid EditStar, Avid Learning Excellerator, Avid Liquid, 
Avid Liquid Chrome Xe, Avid MEDIArray, Avid Mojo, AvidNet, AvidNetwork, Avid NewStar, Avid Remote Response, 
AVIDstripe, Avid Unity, Avid Unity ISIS, Avid VideoRAID, Avid Xpress, AVoption, AVX, Beauty Without The Bandwidth, 
Blacktooth, Boom, C|24, CamCutter, CaptureManager, ChromaCurve, ChromaWheel, Command|24, Conectiv, CountDown, 
DAE, Dazzle, Dazzle Digital Video Creator, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, 
Digidesign Intelligent Noise Reduction, DigiDrive, DigiLink, DigiMeter, DigiSerial, Digital Nonlinear Accelerator, DigiTranslator, 
DINR, DNxchange, do more, DVD Complete, D-Verb, Eleven, Equinox, EveryPhase, ExpertRender, Fastbreak, Fast Track, 
FieldPak, Film Composer, FilmScribe, Flexevent, FluidMotion, FXDeko, G7, G-Rack, HD Core, HD Process, HDPack, 
Hollywood DV-Bridge, Hybrid, HyperControl, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, iNEWS, 
iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, Intelli-sat Broadcasting Recording Manager, Intelli-Sat, InterFX, 
Interplay, inTONE, Intraframe, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, Lightning, 
ListSync, Lo-Fi, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, M-Audio, M-Audio Micro, 
Maxim, Mbox, MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, 
MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, MediaStream, Media Suite, Meridien, MetaFuze, 
MetaSync, MicroTrack, Midiman, MissionControl, Mix Rack, MixLab, Moviebox, Moviestar, NaturalMatch, Nearchive, 
NetReview, NewsCutter, Nitris, NRV-10 interFX, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, 
Open Media Management, Palladium, Pinnacle, Pinnacle DistanTV, Pinnacle Geniebox, Pinnacle HomeMusic, 
Pinnacle MediaSuite, Pinnacle Mobile Media, Pinnacle PCTV, Pinnacle PCTV HD Ultimate Stick, Pinnacle PCTV Nano Stick, 
Pinnacle PCTV To Go, Pinnacle Scorefitter, Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle 
VideoSpin, ProEncode, ProServices, ProSessions, Pro Tools, QuietDrive, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, 
Reel Tape Saturation, RetroLoop, rS9, rS18, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Session, Show Center, Sibelius, SIDON, Soft SampleCell, Soft-Clip Limiter, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, Starplay, SteadyGlide, Streamfactory, Streamgenie, 
StreamRAID, Strike, Structure, Studiophile, SubCap, Sundance Digital, Sundance, Symphony, SYNC HD, SynchroScience, 
SynchroScope, Syntax, Targa, TDM FlexCable, Thunder, Titan, Titansync, TL Aggro, TL AutoPan, TL Drum Rehab, 
TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, Torq, Torq Xponent, Transfuser, 
Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Venom, VideoRAID, Video Slave Driver, VideoSPACE, 
VideoSpin, Vortx, Xdeck, X-Form, Xmon, Xponent, X-Session, and X-Session Pro are either registered trademarks or 
trademarks of Avid Technology, Inc. in the United States and/or other countries.

http://www.avid.com
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Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 
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